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PART I:  INTRODUCTION 
 
System Introduction 
 
The RcgAcs Attendance Control System is a cost effective, powerful security device 
that monitors and controls the access to particular premises. Its complex design allows 
a single PC to control up to 128 of these devices, hence permitting control of 256 doors 
with one computer. It is also equipped with the function to control car park access and 
emergency access system. The package comes along with the EL1000 Control Panel, 
which is the device itself, and the RcgAcs Access Control System Software. 
 
The device can be installed as a standalone component or linked to the PC, but both 
configurations are granted full access to the features provided by the device and runs at 
real time environment. This means that the device is able to store up to 10,000 access 
control transactions regardless whether the PC is turned ON or not, or even during 
power failure situations.  
 
RcgAcs Attendance Control Application Software is a powerful application tool with 
Windows Graphical User Interface (GUI) that provides user-friendly computer 
environment for parameters/data entry, transactions listing, user database configuration 
and storage, and report generation. This tool is able to support 8 PC communication 
buses/ports, with each port controlling 16 RcgAcs Control Panels, hence allowing the 
monitoring of 128 devices (256 doors) with only one control medium (your PC).   
 
 
 

About This Manual 
 
In this manual, the user will be guided with the step-to-step instructions of configuring 
and using this device and the software. A quick start session is being included for brief 
and basic setup of the system settings, allowing basic access control operation without 
fully utilizing the functionality provided.  
 
In the later chapter, Part III – Software Function, the user will be guided through with 
detailed explanation of all the functions offered in the RcgAcs Attendance Control 
System.  
 
The configuration diagram and datasheets were included in the Index pages, along with 
the explanation of the technical terms and names that were used in this manual. Please 
refer to the index page for more information.  
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PART II:  BASIC CONFIGURATION 
 
Device Setup  
 
This will setup the RcgAcs Attendance Control System device to your computer 
application.  
 

1. Connect the device to the PC communication port with RS485 Converter port or 
RS232 Cabling Interface as indicated in the System Connection Diagram.  
Supported card formats include MiFare card formats (used with MiFare readers 
ONLY), EM proximity 125 kHz, HID cards (used with HID readers ONLY), 
Rosslare all ranges.   
Supported readers are ABA-Track II, Wiegand formats (26 bits, 32 bits, 34 bits, 
35 bits, 37 bits), HID keypad, Rosslare keypad, Indala keypad, proximity 125 kHz, 
MiFare, fingerprint readers.  

2. Launch RcgAcs Attendance Control System software, and you’ll be asked to 
select a Comm Port via Comm Port Selection window. Select the appropriate 
Comm Port that is connected to your device. 

3. The software will perform auto scanning on the device and configure it to its 
default setting.  

4. If more than 1 device is connected to the same Comm Port, make sure that the 
physical address setting of the device is set differently.  

5. Once the communication between the device and the software is being 
established, the LEDs (green and orange) on the device will start blinking; this 
indicates the device is ready to be used.  
 
Please refer to Panel Setting in PART III for details in device configuration 

 
 

Quick Start 
 
This session only provides brief information on basic system setup, which only involves 
login/logout functions, communication port selection function, panel/device setting, and 
card holder registration function.  
 
NOTE: This session only touches the brief functions of the system, for more details 
please refer the following chapter – Part III Software Functions. 
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To perform a quick start for the RcgAcs Attendance Control System, please refer to the 
following procedures: 
 

1. Once the device is being set up, select login from the software’s main window to 
access into the program. Key in the default user name and password (user name 
and password are both the same by default): RCG 

2. Once logged in, select System Setup from the side panel to bring down its menu. 
Select Panel Setting to setup the functionality of the access control device.  

i. The system will prompt the user to an empty Panel Setting page, select 
“Insert” button to add in a new Panel Set.  

ii. From the Edit Panel Setting window, type in the reference name for the 
setting under the Tag Name space. Provide some description if desired.  

iii. Choose the access control type for the device under the Panel Type 
option box.  

iv. The bus number is the representative number for the communication port 
that had been selected earlier on. Select the appropriate port from the 
Bus Number selection block.  

v. Adjust the open time and release time (the time for the door to be 
remained open and the time for the lock to be released) of the device 
according to your preference.  

vi. Select the reader type of the device from the Reader Type selection block. 
The rest of the parameters can be left as default. 

vii. Select “OK” and the system will prompt the user to upload the settings 
onto the device. Select “Yes” to complete the setting process.  

3. The user may register the card holders into the system’s database. Card 
registration can be easily done by: 

i. From the main software page, select the “Capture Card” tab underneath 
the tool bar. A Capture Card window shall appear on the screen.  

ii. Scan/flash the user card on the card reader, which is connected to the 
RcgAcs Access Control device.  

iii. Select the “Execute” tab and the system will prompt the user to confirm 
the card registration procedure. Select “Yes” and the system will add the 
new card information into the database.  

 
NOTE: You may flash all the user cards you desire before proceeding to step 
(iii). The system will add in all the user cards at once.  

 
The user may now use the device’s basic functions for simple access control operations.  
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PART III: SOFTWARE FUNCTION 
 

 
 

Figure: Main Window of the RcgAcs Attendance Control System Software 
 
The above figure is the main window of the RcgAcs Attendance Control System 
Software. User can access to all the control panels from the top most menu bar, The 
Transaction List Window is a real-time format space that indicates all the transactions 
carried out, users are automatically brought to this window during start up, and can be 
confirmed by clicking the Transaction List Tab. The Operation Tab will prompt the user 
to another window similar to transaction list window, indicating the operation of the 
device.  
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Figure: Panel Operation Window of the RcgAcs Attendance Control System Software 

 
The window above shows the system panel operation’s current status. The respective 
control panel will turn red when the communication for that controller is off line. User 
may double click on the selected controller to change the controller operation’s setting. 
This is the shortcut link to panel setting. Besides that, user may also upload and 
download the finger print template to that highlighted controller by simply clicking on the 
“Get FP Template” and “Set FP Template” button as shown in the following figure. (This 
function will manipulate all FP templates from the controller) 
 

 
  Figure: Get and Set Finger Print Template to controller. 



 
9 

 

 

 
 

Figure: Card User List of the RcgAcs Attendance Control System Software 
 
The above listing shows the current user holder records in the system. The user may 
highlight the card holder to send and retrieve information. Double clicking on the user 
record will pop up the respective card holder records for editing purposes. The user is 
able to perform any card holder info editing by simply clicking on the command button 
which is located on top of the card holder listing. The selection of the “Get FP Template” 
and “Set FP Template” button will only perform downloading and uploading of 
respective card holder FP records.  
 
 
NOTE:  
During template downloading, any error of the transmission will be recorded. The user is 
able to perform re-send operation by selecting the Error List button which is found at 
transaction listing windows. 
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File Menu 
 
The File Menu is the first menu on the tool bar. The functions include the Log In and 
Log Out functions, the password changing function and the exit function. These 
functions are all listed on the easy access bar as indicated in the previous figure.  
 
 
Log In & Log Out 
 

1. Click on the Login icon from the easy access bar or from the File Menu to 
access the software. The user will be prompted to the following window.  

2. Key-in the user ID and password to log in. The default user ID and password are 
the same: RCG  

 

 
 

Figure: System Log In Window 
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The user can create new login ID and password from the User Account option under the 
System Setup menu. The ID will be indicated at the center bottom of the screen after 
logging in.  
 
NOTE:  
Maximum word length for user ID is 12 characters size  
Maximum word length for password is 15 characters size.  
 
 

 
 

Figure: System Log Out/Exit Window 
 
The user may log out of the software by: 
 

1. Clicking on the Logout icon from the easy access bar or from the File Menu. The 
above window will appear.  

2. Key in the password to log out from the system.  
 
Be reminded that the system is not turned off and is still connected to the device in this 
condition.  
 
To disconnect the software from the device and exit the system:  
 

1. Click on the Exit button on the easy access bar or on the Close option from the 
File menu.  

2. The software will prompt you to turn off the application, click “Yes”. 
3. The above window will appear, key in the password to exit the system.  

 
 
Changing Password 
 
The user password can be changed by any software users who logged into the system. 
The following instructions are the steps to change the password. 
 

1. The user must log into the software beforehand.  
2. Click on the File Menu to bring down the action options, click on the Change 

Password option. 
3. A window asking for old password will appear, key-in the old password (current 

password) for verification. 
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Figure: Enter Old Password 

 
4. Then a new window will appear, key in the new password. 

 

 
Figure: Enter New Password 

 
5. Key-in the new password again for verification. Hit <Enter> or click on the “OK” 

button on the Change User Password window.   
 

 
Figure: Re-enter New Password for Verification 

 
6. Exit the system using the old password.  
7. Log in again with the new password to activate the password and to complete the 

steps.  
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System Setup 
 
Comm Port 
 
Communication Port, or Comm Port for short, is the connection port for data transaction 
between the computer software and the access control devices. The RcgAcs 
Attendance Control System software is designed to be able to interface with 8 Comm 
Ports in total, hence this option allows the user to link/allocate the appropriate port to 
the software’s interface. 
 
It can be easily done by the following steps: 
 

1. Make sure the computer is connected to the device with a communication cable.  
2. Select System Setup menu from tool bar or from the side panel, then select the 

Comm Port option.  
3. A window as shown in the figure below can be seen. Click on the down arrow 

button to select the appropriate port that had been used to link with the 
software’s buses.  

 

 
Figure: Comm Port Selection Window 

 
 

4. Click “OK” to complete the selection. If the wrong port is being selected, the 
system will prompt the user with an error message. 
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Properties 
 
This option allows the user to specify the company information, time attendance posting 
properties, site/area security code, and card holder’s predefined data fields. To make 
changes on these properties, select System Setup menu from the tool bar or from the 
side panel, then select the Properties option.  
 
System Info 
 
This property is to specify the company information that the user would prefer to be 
generated on their reports or their system. The information that can be displayed 
includes the company name and the company logo.  
 

            
Figure: System Info Page 

 
This System Info page is the default page that user would see every time the Properties 
option is being selected. Key-in the company name on the field provided. The user is 
allowed to upload their company logo into the system to be generated on their reports. 
But the logo size must be 100×100 pixels and saved as a BMP file. Just click on the 
“Capture” button to search for your company logo, double click on the picture and the 
logo will be displayed on the Report Logo field. Click “Change” and the information will 
be saved.  
 
However, the application will not take effect immediately. Please exit the system and log 
in again for the changes to take effect. The user should be able to view their company 
name displayed at the top of the software window as indicated in the following diagram. 
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Attendance Auto Posting & Export 
 
This function is being used for attendance filtering and data documentation purposes. 
Enabling this mode will allow the system to automatically update the attendance report 
in a set period of time and automatically rearranging the attendance report documents 
in the system.  
 
To set up this feature, click on the Attendance Auto Posting & Export tab on the 
System Properties window. 
 

 
Figure: Attendance Auto Posting & Export Page 

 

• Enabling the Auto Purging function will allow the system to automatically erase 
the old time attendance transaction files in the specified time line.  

• The Auto Export function will export the time attendance report into the system’s 
root directory, the expfolder (C:\Program Files\RCG \ExpFolder).  

• The report will be kept for a set period of time before it is deleted from the system, 
and the time period can be set from the “Month(s) to Keep” option tab.  

• The Auto Posting feature allows the system to automatically generate the time 
attendance transaction files in a set period of time. This will properly organize the 
time attendance documents and ease up the report generation procedure when 
desired.  
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Site Code Setting 
 
The RcgAcs Attendance Control System allows the user to create 5 different security 
codes for different premises, hence named as Site Codes. Meaning different areas can 
be set with different security code.  
 
To setup Site Code, click on the Site Code Setting tab on the System Properties 
window, your page should look like the following figure: 
 

 
Figure: Site Code Setting Page 

 
“0000” indicates no code has been set. Highlight the “0000” field and enter a 4 digits 
number to set the site code. Hit “Update” to confirm the changes that had been made.  
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Card Holder User Define Field 
 
This software allows the user to create another 6 extra record fields on every card user 
database. Just select the Card Holder User Define Field tab to add in the records. The 
following diagram shows an example of the extra records. 

 
Figure: Card Holder User Define Field 

 
In this example, the user wishes to record the card users’ identity card number, their 
date of birth, marital status, body height and weight, and their contact number. These 
extra records can be registered in each card users’ database from this setting. Just type 
in the desired record in the fields and click “Change” to save this information.  
 
Info: 

Record Field Data length (number of characters) 

User Define #1 30 

User Define #2 30 

User Define #3 30 

User Define #4 30 

User Define #5 30 

User Define #6 30 

Site Code 1 4 

Site Code 2 4 

Site Code 3 4 

Site Code 4 4 

Site Code 5 4 

Company Name 80 
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User Roles 
 
This setting gives the administrator the options to create restriction access for different 
users who logged into the software. Click the System Setup menu to bring down the 
option lists from the tool bar, or from the side panel. Click User Roles to bring up the 
setting page.  
 

 
Figure: User Roles Setting Page 

 
Steps to Create New User Roles: 
 

1. To create new user roles, click on the “Insert” button.  
2. Choose the menu access number (ranging from 1 to 99). 
3. Select the access options that you wish to grant for the others by clicking on the 

selection box shown beside each setting options. The user may switch to other 
menu (System Setup, Database Setup, Reporting, and System Operation) by 
clicking on the menu tab listed on the window.  

4. Selecting/Enabling the View Card PIN No. will enable the login user to view 
every user’s password.  

5. Select “save” to store the setting into database. 
 
The user may also choose to edit the existing User Roles by selecting the “Modify” 
button to make the changes.  
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User Account 
 
This menu is used to create new user ID and password to access this software. The 
password for the new user ID is set to be the same by default; it can be changed later 
by the user themselves.   
 
To create a new user account: 
 

1. Select System Setup menu from the tool bar, then select User Account option. 
The following window will appear.  
 

 
Figure: User Account Window 

 
2. Click on “Insert” to add a new user ID into the system. The following window will 

pop out. 
 

 
Figure: Add User Account Window 
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3. Fill in the ID and the name in the provided space.  
 
NOTE: Password is set to be the same as the User ID by default. 
  

4. Select the User Type for the new account, whether to be an admin, which will be 
granted access to System Setup; or a normal account, which user cannot access 
to System Setup option.  

5. Select the User Roles granted for this new account. Click the “00” tab to bring up 

the User Roles window. Click the next and previous buttons ( ) to 
select the User Roles that you wish to grant for the new user. Click on the 
“Select” tab to confirm the User Roles.  
 
NOTE: To create a new User Roles setting, please refer to the User Roles 
chapter. 
  

6. Select “OK” to confirm the new user account. A reminder window will pop out to 
indicate that user password is set to be the same as user ID by default. Click 
“OK” to complete the new user registration.  
 

 
Figure: Sample User Accounts 

 
After completing the user accounts, click on the “Close” tab to exit the setting.  
You may also choose to delete any of the user accounts as desired.  
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Panel Setting 
 
This option is used to configure the system control panel settings. Or in other words, it is 
used to control the access system for different doors.  
 
To access this option, click System Setup menu from the tool bar or from the side 
panel. Click Panel Setting to view the available panels in the system or to add a new 
panel setting to the database.  
 

           
Figure: Panel Setting Window 

 
To add a new panel setting into database, click “Insert” to bring out the Edit Panel 
Setting window.  
 
To edit an available panel setting in the database, select the panel that you wished to 
modify then click the “Modify” button to bring out the Edit Panel Setting window and 
begin modification. Or, the user may double click on the panel to perform modification.  
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Figure: Edit Panel Setting Window 

 
The parameters of the panel setting are explained in the following table.  
 

Parameters Description 

Tag Name Panel/device name that will be displayed on the log file. 
Description Short explanation of the panel. 
Panel Type This indicates the operation type of the device, which included: 

1. Single door – In/Out Reader 
2. Double door – 2 In Reader 
3. 1-IN/1-OUT Barrier 
4. Emergency Door 
5. Time Attendance Panel 
6. 2-IN/2-OUT Barrier 
7. Alarm Monitoring Panel 
8. i4-Flexi-W Fingerprint Panel 

Bus No. PC communication port to the device/panel. 

Unit No. The device’s physical address. Ranging from 0 to 15. 
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Release Time Time period (second) for the lock to be released. Once 
exceeding the limit, the system will automatically lock the door 
and produce a warning signal/sound. 

Open Time Time period (second) for the door to be remained open. Once 
exceeding the period, the system will generate warning 
signal/sound. 

Security Mode Setting the security level for the device. There are two security 
level for configuration: 
 
HIGH = System will NOT permit entrance or exit if card error is 
detected. 
LOW = System will allow card entrance/exit even there is card 
error.  

Site Type This option allows the user to select the networking system 
used for the device to communicate with the software.  
Select Local site type under normal application.  
User may be required to create and select a new site type for 
long distance monitoring purposes. 
 
NOTE: Please refer to the Site Definition sub-chapter under 
System Setup. 

Suspend Polling This will enable/disable polling for the device. Enabling polling 
will allow the software system to wait and monitor the device 
until the device is ready to be read.  

Access Limits Number of time a person can have access to the premises.  
“0” indicates no access limits.  

Antipassback Reset 
Time 

The antipassback is to prevent double entry of the same card 
on the same premises without exiting the facility beforehand.  
After the antipassback is triggered, this setting will allocate a 
time period before the system is being reset/refresh back to its 
initial status. 
 
Time 00:00 will disable the reset function. 
Only available in Single Door, 1-IN/1-OUT Barrier, and Time 
Attendance Panel.  
 
NOTE: Please refer to Index – Definition and Description 
chapter for in-depth explanation on antipassback function 

General Purpose 
Output TZ 

Time zone setting for general usage.  
 
NOTE: Please refer to Database Setup chapter for information 
on Time Set and Time Zone configuration.   

Interlocking TZ The interlocking system will only permit one door to be opened 
at one time when two doors function is being used, and it is 
controlled using Time Zone setting.  
Hence the Interlocking TZ function allows the user to select the 
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proper time zone for this function.  
 
Only available in Double Door, 1-IN/1-OUT Barrier, and Time 
Attendance Panel. 
 
NOTE: Please refer to Database Setup chapter for information 
on Time Set and Time Zone configuration.   

Antipassback TZ The antipassback function is controlled using Time Zone 
Setting, and the Antipassback TZ function allows user to select 
the time zone that had been pre-configured for this function.  
 
Only available in Single Door, 1-IN/1-OUT Barrier, and Time 
Attendance Panel.  
 
NOTE: Please refer to Database Setup chapter for information 
on Time Set and Time Zone configuration.  

Time Attendance 
Reader 

This feature enables/disables the attendance record function. 

Check Card Expiry 
Date 

Enabling or disabling this feature will toggle the checking 
function. Enabling the function will deny expired card holder’s 
access.   

Reader Type Specifying the reader type that had been used for the device: 
 

1. Wiegand Format (26bits, 32bits, 34bits, 35bits, 37bits) 
2. ABA-Track II 
3. HID Keypad (only for HID brand RFID readers) 
4. Rosslare Keypad 
5. Indala Keypad 
6. Proximity 125kHz 
7. MiFare 
8. Finger print readers 

Name The tag name for the device will be automatically updated to 
this field once the setting is completed.  

Lock Release TZ Time-zone to activate or deactivate the lock release period 
limitation system.  

Push Button TZ Time-zone to activate or deactivate the push button function, 
which is used to release the locking system with just a push 
button.  

Card + Pin TZ Time-zone to activate or deactivate the card and pin access 
feature. The feature can only be used with keypad integration.  

Buddy Mode TZ Time-zone to activate or deactivate buddy mode feature. Buddy 
Mode feature is a high security procedure mode that requires 2 
valid cards to be presented to the device to gain access.  

Release on Fire 
Alarm Event 

Enabling this feature will release the door lock when fire alarm 
event is detected, regardless of the time-zone setting.  

Siren TZ Set Time zone to trigger siren/notification alarm.  
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Alarm Setting An option tab that is only available when selecting Emergency 
Door mode or the Alarm Monitoring Panel for the Panel Type 
selection. The options provide adjustment for time zone or delay 
to arm/disarm the alarm.  
 

• Arm Delay Time 

• Disarm Delay Time 

• Alarm Relay Trigger Time 

• Alarm Arming Time Zone  
Input Point Setting An option tab that is only available in Emergency Door mode 

and Alarm Monitoring Panel.  

 
 
Site Definition 
 
The Site Definition feature is used for long distance monitoring purposes, as a remote 
for the RcgAcs Attendance Control System device using the Ethernet as the 
communication medium.  
 
To create a new site definition: 
 

1. From the System Setup menu, select Site Definition to access into the following 
main window. Select “Insert” to create new site. 

 

 
Figure: Site Definition Main Window 
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Figure: Edit Site Record Window 
 

2. Enter the name for the new definition in the Site Code field; provide some 
description for the new setting.  

3. Key in the IP address of the monitoring computer (i.e. your PC) in the IP 
Address field. Enter a Host Name for your network.  

4. Key in the Socket connection port number of the monitoring computer. 
5. Click on the “OK” button to complete the new site registration procedure.  
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Database Setup 

 
Time Interval Set 
 
The time interval set is an option to activate or deactivate the access control features on 
particular time frame for one particular day. It is the primary time block description 
before entering Time Zone database setting. The setting describes the time frames for 
ONE day operation, each day is provided with the option to allocate three time frames.  
 
To add in a new time set or to view/modify the available time set, click on the Database 
Setup menu from the tool bar, or from the side panel to bring down the options, click on 
the Time Interval Set option to open the window as shown in the figure below.  
 

 
Figure: Time Interval Set Window 

 
The two time sets (Time Set “000” and Time Set “001”) are the default time sets created 
by the manufacturer that cannot be deleted nor modified. Time Set “000” indicates no 
access setting, meaning that there would be no access to the premises at all time if this 
setting were chosen, whilst Time Set “001” allows access at all time (24 hours).  
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Follow the instructions below to add in a new time set: 
 

1. Click “Insert” to open Edit Time Set Record window shown in the following 
diagram.  

 

 
Figure: Edit Time Set Record Window 

 
2. Choose the appropriate time set number from the “Time Set No.” space. Type in 

some descriptions to note down the time set function.  
3. Set the time frame by clicking the up and down arrow or by keying-in the digit in 

the first interval frame (Interval 1). The “Hour” column ranged from 0 to 23 at 
max. The “Minute” column ranged from 0 to 59.  

4. Set the time frame beginning with Interval 1, the other two can be left alone if it 
is unnecessary.  

5. Click on the “OK” button to confirm the setting.  
 
To modify an existing setting, just select the desired time set, click on the “Modify” tab 
from the Time Interval Set window and begin the modification.  
 
Info: 
Only 128 time interval sets can be created for this system.   
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Time Zone Set 
 
This setting is used to activate or deactivate the system features for one week time 
frame. It is made up of 8 sets of Time Interval Sets, each representing one day of the 
week with an extra row representing the holiday that might be available in a particular 
week. The following figure indicates the Time Zone Set window that will appear once 
accessed.  
 

 
Figure: Time Zone Set Window 

 
This window can be activated by selecting Database Setup menu to bring out the 
options from the tool bar or from the side panel, select Time Zone Set to access into 
the setup page.  
 
Same as the Time Interval Set, there are two default settings available in the database 
that cannot be deleted nor modified. The TZ “000” indicates no access granted at all 
time; TZ “001” indicates the opposite.  
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The user may add in new time zones by selecting the “Insert” button. The following 
window can be seen on the screen. 
 

 
Figure: Edit Time Zone Record Window 

 
To set the time zone: 
 

1. Click on the down arrow button to view the time interval set available. 
2. Select the time interval set that you desired for the day. Repeat the selection 

procedure for other days. 
3. Click “OK” once completed the new time zone insertion.  

 
Modification of the existing time zone can be done by selecting the time zone and click 
“Modify” button to begin modification.  
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Access Roles 
 
An Access Role is a set of time zone records for a particular device. The system will 
check for the card validity at a particular time zone by comparing the current time with 
the recorded time zone sets. Unmatched time zone sets will deny the card holder’s 
access into the premises.  
 
Click on the Database Setup tab from the tool bar or the side panel to bring down the 
menu, select Access Roles to view the settings for the devices.  
 

 
 

Figure: Access Roles Main Window with Sample Doors (Door 1 & Door 2) 
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The user may add in new access roles by the following procedures: 
 

1. Select “Insert” tab to bring out the following editing window.  
 

 
Figure: Add Door Access Record Form 

 
2. Choose the desirable access number from the “Access No.” tab. Enter some 

description to describe the role. Note that Access “000” and “001” are the default 
access roles that cannot be removed nor modified.  

3. Click on the “000” tab to bring out the Time Zone Set window. Select the 
desirable time zone from the window and hit “Select”. 

4. Once done, click on the “OK” tab to confirm the insertion of a new access role.  
5. The software will prompt the user to confirm the download of the new role(s) onto 

the device. Click “Yes” to confirm download.  
 
The user may also modify the existing roles by first, select the desired access role then 
select the “Modify” button to begin modification.  
 
NOTE: 
Access Role “000” indicates no access at all. 
Access Role “001” indicates free access to premises at all time.  
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Card Holder 
 
This option allows the system to register the card holder’s information into the database. 
To view the card holders’ data, select Database Setup tab from tool bar or side panel to 
bring down the menu, select Card Holder option to open up the Card Holder page as 
indicated in the following figure.  
 

 
Figure: Card Holder Database 

 
The database contains a space to list down all the card holders, the card information, 
and the card’s last scanned location data. The user may set another six information 
fields on the User Define Fields section to record the card holder’s data.  
 
NOTE: Please refer back to Properties under System Setup chapter for information on 
User Define Fields setting.  
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Insert New Card 
 
New Card Registration via Software 
 

1. To insert new card holder information into the database, first select the “Insert” 
tab to open the Edit Card Holder Record window.  

 

 
Figure: Edit Card Holder Page 

 
2. Insert the card number in the “Card No.” space.  

 
NOTE:  
Card number MUST be a 10-digit number. 
If the number registered is less than 10 digits, fill in zeroes ‘0’ in front of the 
number to fill up to 10-digits.  
  

3. Enter the staff number and his/her name into the “Staff No.” space provided.  
4. Select the appropriate department, job title, access roles and working hour 

from the selection tabs.  
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NOTE:  
Please refer back to Access Roles chapter under Database Setup for access 
roles setting. The settings for department, job title and working hour will be 
covered in the following chapters.  
  

5. Select the card expiry date as desired from the Expiry Date set.   
6. Select the Active Flag option for the user. Selecting “Yes” to enable the card 

usage for the user. Selecting “No” (by clicking once on the “Yes” tab) to disable 
the card usage.  

7. Choose the desirable card type. There are two types of card available in the 
system:  

• Access Card 

• Master Card 
8. Buddy No. is a match pair identification number used for Buddy Mode matching 

procedure. Select the buddy number for the card user.  
 
NOTE: Please be noted that digit ‘1’ is an exclusive digit that is set to match with 
all buddy numbers. 
 

9. The user may also add in the card holder’s photo into the database record.  
 
NOTE: Be reminded that the photo must be saved in .jpg format to be used in 
the database. 
  

10. Select “OK” to confirm new card registration. The system will prompt user to 
download the card record to the device. Select “Yes” to complete the new card 
registration procedure.  

 
 
 
New Card Registration via Card Scanning Procedure 
 

1. For card registration via card scanning procedure, please ensure that the device 
is connected to a card reader.  

2. The user is not required to open any option pages. Just logging in to the system 
will do. Notice that from the software’s main menu, a “Capture Card” option is 
available under the tool bar: 
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Figure: System Main Page – “Capture Card” Option Tab Indication 

 
3. Click on the “Capture Card” option to bring out the card capture window 

indicated in the following figure: 
 

 
Figure: Capture Card Window 

 
4. Scan/flash the new user card on the card reader.  
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5. Select the “Execute” tab and the system will prompt the user to confirm the card 
registration procedure. Select “Yes” to add the new card information into the 
database.  

 
NOTE: You may flash all the user cards you desired before proceeding to step (5). The 
system will add in all the user cards at once.  
 
Parameters Modification 
 
The RcgAcs Attendance Control System provides option to edit and even group edit 
the card holders’ database. The group edit option allows the user to edit and 
synchronize the parameters of several card holders with one selection.  
 
To Modify a Single Card Holder’s Settings: 
 

1. Select the card holder that you wish to modify from the Card Holder Database 
window.  

2. Select the “Modify” tab to bring out the Edit Card Holder Record page and 
begin modification.  

 
To Modify a Group of Card Holders’ Settings: 
 

1. Select the “Group Edit” tab from the Card Holder Database window. A Group 
Edit window will appear as shown in the following figure: 
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Figure: Group Edit Window (sample) 

 
2. From the Group Edit window, select the Parameters option that you wish to 

modify from the parameters option tabs.  
3. Select the card holders that you wish to modify from the card selection screen. 

Just click on the empty box in front of the card number. Once selected, you will 
see a tick in the box. To deselect the card, just simply click on the check box 
again.  

4. Begin modification by selecting the parameters available in the parameters box. 
Noticed that there is a “Current” setting and a “Change to” setting in every 
parameter options. The “Current” setting may be ignored as it does not contribute 
to any changes to the parameters.  

5. To modify the parameters, select the “Change to” setting tab, and change the 
parameter as desired.  

6. Select “Execute” to complete the modification.  
 
NOTE:  
The user is only allowed to change one parameter option at one time. This means if 
the user wish to change the department and job title of card holder “01”, “02” and “03”, 
you may only allowed to change the department parameter following the guide above. 
After executing, repeat the steps from step one to begin modification for job title 
modification.  
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Edit Pin 
 
The Card Holder’s pin can be easily modified from the “Edit Pin” option available on 
the Card Holder Database window.  
 

 
Figure: Pin Number Entry Window 

 
Just select the desired card holder and select the “Edit Pin” tab, the above window will 
appear on the screen. Enter the pin number in the high-lighted space. Select “OK” to 
confirm the pin entry.  
 
Search Card Holder Record 
 
The system provides users with the feature to locate the card holder’s record in the 
database with a user-friendly search engine. Just click on the “Locate” tab in the Card 
Holder Database window to bring out the search engine shown in the following figure.  
 

 
Figure: Search Card Holder Record (Search Engine) 

 
The user may choose to search by card number or by name or by staff code. Select 
the search preference and key-in the code/name in the space provided. Hit “OK” to 
initiate the search.  
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Department Setting 
 
The user can input the department name and descriptions into the database to be 
applied on the card holder database report. To initiate the department settings, select 
the Database Setup tab from the tool bar or the side panel to bring down the menu. 
Select Department Setting to begin configuration.  
 

 
Figure: Department Setting Window 

 
From the Department Setting window, the user may insert new departments into the 
database by selecting the “Insert” tab to bring out the Add Department Record 
window shown in the following figure: 
 

 
Figure: Add Department Record 

 
Enter the Tag Name, which is the department name into the space provided. Include 
some descriptions to describe the department. Select “OK” to add the record into the 



 
41 

 

database. To modify the existing department, select the department name and click 
“Modify” to begin modification. Be noted that the Tag Name cannot be modified; only 
the Description can be changed in the setting.  
 
Info: 
Tag Name – 12 characters length 
Description – 30 characters length 
 
 
Job Title Setting 
 
This setting allows the user to create a job description record that will be implemented 
into the card holder database report. To set the job title, select Database Setup from 
tool bar or side panel to bring down the menu, select Job Title Setting option to access 
into the setting page.  
 

 
Figure: Job Title Setting Window 
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The user may add in new job title into the database by clicking the “Insert” tab. From 
the Add Job Record window, enter the job title into the Tag Name space and provide 
some description for the title. Click “OK” to confirm the setting and update into the 
database.  
 

 
Figure: Add Job Record 

 
To modify an existing setting, select the desired title and select “Modify” tab to begin 
modification. Be noted that the modify setting only allows modification for the description 
only.  
 
Info: 
Tag Name – 12 characters long 
Description – 30 characters long 
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Working Hour 
 
The user may specify the company’s working time table and shift data with the aid of the 
Working Hour Setting. The data is used for time attendance calculation and as a 
reference for other settings. To access into this setting page, select Database Setup 
from tool bar or the side panel to bring down the menu, select Working Hour to open 
up the listing page shown in the following diagram: 

 
Figure: Working Hour Setting Page 
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The user may insert a working hour setting into the database by following the 
procedures below: 
 

1. Select the “Insert” tab to bring out the following window. 
 

 
Figure: Edit Work Hour Window 

 
2. Enter the work hour name into the Tag Name space. Provide some description 

for the setting.  
3. Select the work hour duration from the “From/To” column for each day.  
4. Select the lunch hour set for each day if required. 
5. The user may enable the Over Time Setting by selecting “Yes” for OT Claims 

option, or disable the option by selecting “No” for the option.  
6. User may also setup a grace period under the Grace Time Setting. Just key in 

the time (in minute) in the provided field will do.  
7. Select “OK” to confirm the setting.  

 
To modify an existing work hour, just select the name tag of the work hour and hit 
“Modify” tab to begin modification.  
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Holiday Set 
 
The Holiday Set is being used as part of the time zone setting, providing calculation for 
system operating time zone by taking into the consideration of holidays that may occur 
in the mean time.  
 
To access into the Holiday Set option, Select Database Setup option from the tool bar 
or the side panel to bring down the menu. Select Holiday Set to begin configuration.  
 

 
Figure: Holiday Set Window 

 
The system provides 60 slots for holidays edit. Just click on one of the empty slots to 
begin configuration, or click on the existing slots to begin modification.  
 

 
Figure: Edit Holiday Window (Modification Window) 

 
Select the desired day and month in the provided slots. Enter some description to define 
the holiday set. Select “OK” to confirm the setup.  
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Click “Clear” to erase the selected existing set. Once setup is completed, select 
“Close” to exit the setup system. 
 
 

Reporting 
 
The RcgAcs Attendance Control System allows different report generating, previewing, 
and printing for different functions such as the transaction listing, the transaction files, 
system setting report, and also the card holders’ time attendance report.  
 
Transaction Listing 
 
The Transaction Log records all the activities gone through the software, and the user 
can preview the log report and even filter out the unwanted records in the report, 
preparing the report for printing and back up purposes.  
 
To view this report, click on the Reporting tab from the tool bar or from the side panel 
to bring down the menu. Select Transaction Listing to bring out the Transaction Log 
File Lister window. 
 

 
Figure: Transaction Log File Lister Window 

 
1. Select the transaction date that you wish to view from the Transaction Date 

Selection box.  
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2. Select the time zone desired for the report from the Time box. 
3. The user is given the option to filter out the unwanted records from the report. 

The options provided are:  

• Card Number Filter – to select only the card number that you wish to 
view.  

• Staff Number Filter – selection by staff number. 

• Department Filter – selecting the department that you wish to view. 

• Job Title Filter – selection by job title. 

• Control Panel Filter – view report for particular device only. 

• Event Filter – selecting particular event/action recorded to view. 
 
Note: Select “Ignore” to disregard the filtering.  

 
4. Select the report sorting order from the Sort Order box and hit “OK” to preview 

the report.  

5. From the preview page (Print Preview), select the Print Icon ( ) to print out 
the report as back up purposes.  

 
 
Time Attendance 
 
The Time Attendance function summarizes the card holder’s daily and monthly 
attendance into report format.  
 
NOTE: Please make sure that the Working Hour setting for each card holders are 
properly defined in the Card Holder Database before generating a time attendance 
report.  
 
To view the Time Attendance report: 
 

1. From the Reporting menu, select Time Attendance tab to open up the Report 
Selection window.  
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Figure: Report Selection Window 

 
2. There are 12 different attendance report listings available for user’s selection. 

Just click on the preferred option to view the report. 
 

• Early In Listing 

• Early Out Listing 

• Late In Listing 

• Late Out Listing 

• Incomplete Swipe Listing 

• Absentee Listing 

• Lunch Break Listing 

• Daily Summary Listing 

• Monthly Summary Listing 

• Attendance Time Card Listing 

• Attendance Summary Listing 
 

3. The user shall be prompted to the filtering window where the user can select the 
type of filtering for the report.  
The following diagram shows a filtering window for the Attendance Summary 
Listing report:  
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Figure: Filtering Window Sample – Attendance Summary Report 

 
4. After selecting the filtering method and the Sort Order for the report, select the 

“Preview” tab to view the report. 
The following figure shows the report sample of the Attendance Summary Listing: 
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Figure: Time Attendance Report Sample – Attendance Summary Listing 

 
5. The user may print out the report for backup purposes.  

 
 
System Setting 
 
This function enables the user to view the system database settings in a summarized 
report format. To view the report, first access to the System Setting main window by 
clicking on Reporting to bring down the option menu, select System Setting to open 
the Configuration Setting Reports window shown in the following figure. 
 



 
51 

 

 
Figure: Configuration Setting Reports (System Setting Main Window) 

 
The settings that can be viewed in this report, as shown in the above figure, include: 
 

• Time Interval Setting – Time Interval Set report 

• Time Zone Setting – Time Zone Set report 

• Access Level Setting – Access Roles setting report 

• Control Panel Setting – Panel/device setting report 

• Job Title Listing – Job Title report 

• Department Listing – Department setting report 

• Software User Listing – software users report 

• Card Holder Listing – card holders’ report 
 
To view the report, just click on the desired options will do. However, the system 
provides filtering options for Card Holder Listing report.  
 
To view the Card Holder Listing report: 
 

1. From Configuration Setting Reports window, select Card Holder Listing. The 
following window will appear.  
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Figure: Card Holder Database Report 

 
2. Choose the filtering method desired, i.e. filtering by Card Number Filter, or Staff 

Number Filter, Card Holder Name Filter, Department Filter, Job Title Filter, 
or Shift Filter.  

3. The user may switch off the filter mode by selecting the Filter Off box.  
4. Choose the sort order of the report. There are four sorting orders available in 

the system: 
 

• By Card Number Order 

• By Staff Number Order 

• By Staff Name Order 

• By Access Level Order 
 

5. Select the report format from the Report Type option. The user may select to 
view the report with the card access data or with the user defined data. 

6. Select the “Preview” tab to view the report.  
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View Transaction 
 
The View Transaction function provides the user with the capability to retrieve the past 
event log files for viewing purposes. To access into this function, select Reporting 
option from the tool bar or from the side panel to bring down the menu, select View 
Transaction option to open up the Log File Viewer window as indicated by the 
following figure.  
 

 
Figure: Log File Viewer Window 

 
To view a file: 

1. Select a transaction date that you wish to view from the Select Transaction Log 
File  

2. Select the “Open This Transaction Log File” to view the log records 
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System Operation 
 
Send Setting 
 
The Send Setting operation will upload the system’s settings or commands to the 
devices. To access into this module: 
 

1. Select System Operation tab from the tool bar or side panel, from the option 
manual, select Send Setting option to open the following window. 
 

 
Figure: Write Setting to Controller Window 

 
2. Select the commands that you wish to be addressed to the device from the 

command tabs: Card User Command, Panel Parameters, Operation Command, 
Alarm, and Operation Command.  

3. Select the actions desired from the Command Action tab.  
For Card User Command, you may also select the range of card users or 
department that you wish to specifically address the commands.  

4. Select the devices that you wish to address the commands by clicking on the 
small box in front of the device name.  
The user may select all the devices by selecting the “Select All” tab or cancel all 
the selections from the “Unselect All” tab.  
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5. Hit the Execute button to send the system settings/commands to the selected 
devices.  

 
 
Retrieve Setting 
 
This setting allows retrieval of parameters and data from the device back into the 
system for verification purposes. To access into this menu: 
 

1. From System Operation, select Retrieve Setting option and the Retrieve 
Control Panel System Information window shall appear. 
 

 
Figure: Retrieve Control Panel System Information 

 
2. Select the information that you wish to acquire from the Command Action bar. 

The information that can be retrieved: 
 

• Panel Parameters  

• Time Interval 

• Time Zone 

• Date Time 

• Version Number 

• Access Roles 

• Card Holder List and 

• Holiday List 
 

3. Select the panel/device from which you want to retrieve the information.  
4. Select Execute to begin data retrieval.   
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Backup & Restore 
 
The RcgAcs Access Control System allows the user to create backups for the system 
settings and provides restore settings feature for the software.  
 
Create Backup Procedure: 
 

1. From the System Operation option, select Backup & Restore to open up the 
following window. 
 

 
Figure: Backup and Restore Tool – Backup Window 

 
2. Click on the “Add File to Backup List” tab, the software will prompt user to 

select the file type that wished to be saved as backup. There’re two types of file 
that can be saved as backup: System Data File and the Transaction Log File.  

 
Figure: File Selection Window 
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3. After selecting the file type, the user may now select the file that is to be saved 
as backup. You may select files from different folder by toggling the Look In field 
from the selection window (or the Open window).  

4. From the selection window, click on the Open tab to open up the file that wished 
to be saved as backup.  

5. Select the “Create Backup Archive” tab to compile and save the backup files. 
Assert the name for the backup files in the designated field, select “Save” to 
complete the procedure.   

 
Selecting the Clear Backup List tab will delete all the backup items on the list.  
 
System Restore Procedure: 
 

1. From System Operation menu, select Backup & Restore option to open up the 
Backup and Restore Tool window. Select the “Restore” tab on the top left 
corner of the window to open up the Restore Window as shown below.  

 

 
Figure: Backup and Restore Tool – Restore Window 

 
2. Select the folder where you saved your backups, the list of backup items shall be 

displayed in the field under the folder column.  
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3. From that field, select the file that you wish to restore to the system. The backup 
item’s information shall be displayed at the Archive Title field and the Content 
field.  

4. Select the Restore Mode for the system restoration procedure.  
5. Choose the Restore Path for the system. Original Path selection will overwrite 

the existing files. Selecting Other Path option will provides restoration on 
different file path, in which the user is required to specify.  

6. Select the Restore Backup File to complete the system restoration procedure.  
 
 
Reindex Database 
 
The reindex feature allows the RcgAcs Access Control System to re-arrange the 
database management to allow better and faster processing for the system.  
 
To begin the reindex procedure, just select the System Operation menu from the tool 
bar or from the side panel to bring down the option list, select Reindex Database and 
the system shall perform the procedure automatically.  
 

 
Figure: Reindex window 
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Load Report 
 
The Load Report option allows the user to load the saved reports for preview, print and 
backup purposes.  
 
To load a saved report, select System Operation menu from the tool bar or from the 
side panel, select Load Report (Load Saved Report) option to view the saved reports 
in the Print Preview window.  
 

Click on the Load Report icon ( ) from the print preview window, then select the QRP 
report file for preview.  
 
  

 
 

Figure: Load Report Print Preview Window 
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PART V: INDEX 
 
System Connection Diagram 
 
Device Installation – Single Door Mode 
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Device Installation – Dual Door Mode 
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Device Installation – 1-IN/1-OUT Barrier / Car Park System Mode 
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Device Installation – Emergency Door Monitoring Mode 
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Device Installation – I4Flexi-W Connection (Single DoorConnection) 
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Device Installation – I4Flexi-W Connection ( IN & Out Reader Connection) 
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System Datasheet 
 
Overall Features: 

1. Multiple operating modes 
2. Full external proximity connection 
3. Supporting up to maximum of 5000 card users and 10000 log transactions 

storages 
4. Supports multiples proximity reading formation 
5. Supports Alarm and General Purpose relay output 
6. PC software connection for back end reporting and monitoring 

 
System Features in Detail: 

1. 5000 cards and 10000 log transaction storage 
2. 128 sets of time interval sets 
3. 128 sets of time zone settings 
4. 128 sets of door access level 
5. 60 sets of holidays setting 
6. Door’s lock release time ranging from 0 to 99 seconds 
7. Door’s open time ranging from 0 to 99 seconds 
8. Support door lock auto release by time zone control 
9. Support 2 doors access mode or 2 car park access mode 
10. Support antipassback auto reset 
11. Support 10 digits card number reading 
12. Three operation modes are available 

• Card Only mode 

• Card & PIN mode 

• PIN only mode 
13. Exit push button with time zone control 
14. 5 facility code settings (Site Code) 
15. 10 sets of local common PIN setting 
16. Dual Card mode by time zone control (Buddy Mode) 
17. Support integrated keypad reader via Wiegand connection 
18. General purposes relay output by time zone control 
19. Support PC downloading/uploading on system data 
20. Support master card and alarm card mode 
21. Duress alarm detection 
22. Support Pulse door open, Security On/Off, Inhibit On/Off operations 
23. Support Wiegand reader, ABA track 2 readers, HID keypad, Rosslare keypad, 

and Indala keypad 
24. AC power input failure detection 
25. Support 2 external buzzer and LED connection 
26. Onboard LED and LCD for status display 
27. 16 keypad connection onboard 
28. Equipped with RT clock system with backup battery 
29. Equipped with RS485 and RS232 connection on board 
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DC Electrical Specification 
 

No Parameter Max.Limit 
1 Operating Voltage 9VDC - 14VDC 

2 Operating Current 500mA 

3 Operating Frequency 24MHz 

4 Operating 
Temperature 

60 Celcuis 

5 Operating 
Environment 

0% to 95% non condensing 

6 Processor  16bits MCU design 

7 Non - volatile memory Flash Memory 128KBytes 
SRAM 1MBytes 

8 Time & Clock Real Time Clock with battery backup 

9 Communication RS232 communication 
RS485 communication 

10 Display 2x20 Characters LCD display module 

11 Audible Alert Onboard 12VDC buzzer 
Each reader having own buzzer output 

12 Output Point 1A Relay for door 1 lock system 
1A Relay for second door lock system 
1A Relay for General Purpose Output OR event 
output. 
 

13 Input Point 4 TTL inputs for door sensor and push button. 
2 TTL input for car parking sensor loop 
 

14 Watchdog reset Built-in onboard external watchdog 
Built-in MCU internal watchdog 
 

15 Power On Reset Equipped with 4.7Vdc triggering threshold voltage 
level.  

16 Protection Built in TVS protection for every input point and 
communication cable 
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Definition and Description 
 
Access Limit A user-specified access count. The system will deny access on 

the premises once the access limit is being exceeded.  
Antipassback This function prevents double entry on the same premises 

without exiting the area beforehand. It is also being used to 
prevent more than one person accessing into the premises with 
the same card. Usually used in car park premises or high 
security facilities.  
This function is controlled by time zones (learn more about time 
zone in Database Setup Chapter – Time Interval Set & Time 
Zone Set) 
Only available for Single Door IN/OUT function, 1-IN/1-OUT 
Barrier function, and Time Attendance Panel.  

Buddy Mode This feature only allows access when two valid cards are being 
presented on the reader. It is mainly used for high security 
premises. 

Interlocking 
System 

This system is used to monitor access of two doors that allows 
only one door to be opened at one time. It is controlled by time 
zone such as the Antipassback function. 
(learn more about time zone in Database Setup Chapter – 
Time Interval Set & Time Zone Set)  
Only available for Double Door 2IN function, 1-IN/1-OUT Barrier 
function, and Time Attendance Panel.  

Panel / Device Both are the terms for the RcgAcs Access Control System 
hardware device.  

Push Button 
Release 

This is being used to manually unlock the access, or to force 
release the lock system. A time zone control is being used to 
specify the activation or deactivation of this feature.  

  


